
3

If you are coming to SolidWorks from Inventor, Solid Edge, or another 
program in that class, you will find SolidWorks to be very familiar 
territory, with a similar if not identical design philosophy. SolidWorks 

also shares a lot of underlying structure with Pro/ENGINEER, and if you are 
coming from that product, there will be some relearning, but much of your 
training will be transferable.

If you are coming from 2D AutoCAD, CADKEY, or MicroStation, 
SolidWorks may at first cause a bit of culture shock for you. However, once 
you embrace feature-based modeling, things will go more easily. As you will 
see, SolidWorks, and in fact most solid modeling in general, is very process-
based.

Regardless of how you arrived here with this SolidWorks Bible in your hand, 
here you are. Together we will progress through basic concepts to advanced 
techniques, everyday settings, and subtle nuances. This book will serve as 
your tutor and desk reference for learning about SolidWorks software.

This chapter will familiarize beginners with some of the tools available to 
make the transition, and with some of the basic facts and concepts that you 
need to know to get the most out of SolidWorks.

If all you want to do is to start using the software, and you are not concerned 
with understanding how or why it works, you can skip directly to Chapter 4 
for sketches or Chapter 5 to start making parts, assemblies, and drawings. Of 
course, I recommend getting a bit of background and some foundation.
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Starting SolidWorks for the First Time
SolidWorks has many tools for beginning users that are available when the software is installed. A 
default installation presents you with several options when the software is started the first time. 
Following is a catalog of these options and how to get the most benefit from them.

If you plan to go to formal SolidWorks reseller-based training classes, it is a very good idea to go 
through some of the tutorials mentioned in this section first; this way you are prepared to ask edu-
cated questions and have a leg up on the rest of the class. You will get more out of the training 
with the instructor if you have seen the material once before.

SolidWorks License Agreement
It is useful to be familiar with what this document says, but the agreement does not have any bear-
ing on learning how to use the software other than the fact that it allows for a Home Use License. 
Many users find this part of the license agreement, shown in Figure 1.1, helpful. The primary user 
of the license at work is also allowed to use the license at home or on a portable computer. This is 
often a good option for learning, additional practice or completing the design of the deck or soap-
box derby car. If your business uses floating licenses, the rules are somewhat different. Contact 
your reseller for details. In any case, select Accept to get past the License Agreement page.

 FIGURE 1.1

The SolidWorks License Agreement

Welcome to SolidWorks
The Welcome to SolidWorks screen, shown in Figure 1.2, is the next thing to greet you. This helps 
you establish what type of tools you would like to see in the interface and gives you some help 
options. You may not get the chance to see this dialog box if someone else, for example an IT per-
son, has installed and done an initial test on your software for you.

Quick Tips
Quick Tips enables balloons with tips to help you get started with several tasks. For example, the 
first Quick Tip you see may be this one, shown in Figure 1.3. When you begin to create your first 
document in SolidWorks, a Quick Tip helps guide you on your way.
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 FIGURE 1.2

Welcome to SolidWorks screen

 FIGURE 1.3

New SolidWorks Document Quick Tip

As you begin working, Quick Tips displays a box, shown in Figure 1.4, at the lower-right corner of 
the Graphics Window that offers context-sensitive help messages. As you work with the software, 
these messages change to remain relevant to what you are doing.

You can turn Quick Tips on or off using the small square on the Status Bar in the lower-right cor-
ner, as shown in Figure 1.5. You can turn the Status Bar itself on or off in the View menu; how-
ever, the Status Bar serves many useful purposes, even for advanced users, so I recommend you 
leave it turned on. You can also turn off Quick Tips in the Help menu by selecting Quick Tips. The 
on/off setting is document-type sensitive, so if you turned Quick Tips off in part mode, you will 
need to do it again for assemblies and drawings, as well. Quick Tips are a great way to get going or 
to get a little refresher if it has been a while or several versions have gone by since you last saw the 
software, but you shouldn’t need them forever.
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 FIGURE 1.4

The main Quick Tip window

 FIGURE 1.5

Turning Quick Tips on or off

The first time you create a document, you will be prompted to select units for your default tem-
plates, as shown in Figure 1.6. This is an important step, although you can make changes later if 
needed. SolidWorks stores most of the document-specific settings in document templates, which 
you can set up with different settings for each type of document — parts, assemblies, and draw-
ings. More information on part and assembly templates can be found later in this chapter. Drawing 
Templates are described in detail in Chapter 20.

The main significance of this default template unit option is not so much the units as the dimen-
sioning standard that is selected. ISO (International Organization for Standardization) and ANSI 
(American National Standards Institute) standards use different methods of projecting views. ISO 
is typically a European standard and uses First Angle Projection, while ANSI is an American stan-
dard and uses Third Angle Projection. The standard projection used throughout this book is Third 
Angle.
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 FIGURE 1.6

Default template units selection

The difference between Third and First angle projections can cause parts to be manufactured 
incorrectly if those reading the prints (or making the prints) do not catch the difference or see that 
there is some discrepancy. Figure 1.7 demonstrates the difference between the two projection 
types. Make sure to get the option correct. If someone else, such a computer specialist who is not 
familiar with mechanical drafting standards, initially sets up SolidWorks on your computer, you 
will want to verify that the default templates are correct.

 FIGURE 1.7

Differences between First (left) and Third (right) angle projections

Notice that the icons in the View Orientation drop down are arranged in a Third Angle projection 
fashion. This might be confusing for people accustomed to using First Angle.

Another setting affecting projections that you will want to check is found at Tools ➪ Options, 
Display/Selection ➪  Projection type for four view viewport. This does not follow the dimensioning 
standard selected for the default templates or the country in which the software is installed.
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Online documentation
Several types of online documentation are available to help SolidWorks learners along their path. A 
great place to start is with the SolidWorks Resources tab of the Task Pane (on the right side of the 
screen). This is the first tab in the list with the Home icon. The Getting Started section of the 
SolidWorks Resources tab is shown in Figure 1.8.

 FIGURE 1.8

Getting Started on the SolidWorks Resources tab of the Task Manager

Tutorials
Following the link in the Help menu to the Online Tutorials leads you to a list of tutorials on 
subjects from sheet metal to macros, in parts assemblies, and drawings. These tutorials are certainly 
worth your time, and will build your skills and knowledge of basic functionality. This SolidWorks 
Bible distinguishes itself by going into far more detail and depth about each function, adding 
information such as best practice, performance considerations, and cautionary data, and acting as a 
thorough desk reference. The purpose of this book is not really to duplicate all of the resources for 
beginners, but to take the information into far more depth and detail, and answer the “why” 
questions instead of just the “how” questions.

What’s New
With every release, SolidWorks publishes a What’s New document to help you keep up to speed 
with the changes. This is typically a PDF file with accompanying example files. If you have missed a 
version or two, reading through the What’s New files can help get you back on track. Again, don’t 
expect a lot of detail or interface screen shots, but it should at least introduce the basic changes.

Moving from AutoCAD
In the Help menu is a selection called Moving from AutoCAD. This is intended to help 
transitioning users acclimate to their new surroundings. Terminology is a big part of the equation 
when making this switch, and figures prominently in the Moving from AutoCAD help file.

Likely the most helpful tools in Moving from AutoCAD are the Approach to Modeling and 
Imported AutoCAD Data sections. This information is useful whether you are coming to 
SolidWorks from AutoCAD or another CAD package.
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Online User’s Guide
The Online User’s Guide is the traditional Help file. You can use either the Index or Search 
capabilities to find what you are looking for. The Online User’s Guide contains screen captures and 
animations, sample files, and even a separate API (programming) help file. Frankly, it is not 
incredibly detailed, and often skips over important facts like what you might use a certain function 
for, or what the interface looks like, or even where you might find the command in the first place. 
The SolidWorks documentation is set to get some upgrades, so it remains to be seen if this is really 
an improvement or not. Meanwhile, this SolidWorks Bible fills in most of the gaps in information 
about the standard version of the software.

Tip of the Day
SolidWorks Tip of the Day is displayed at the bottom of the SolidWorks Resources tab of the Task 
Pane. Cycling though a few of these or using them to quiz coworkers can be a useful skills-building 
exercise.

Hardcopy documentation
Hardcopy documentation has regrettably dwindled from all software companies. Software manu-
facturers often claim that keeping up with the changes in print is too much work and inefficient. 
Still many users prefer to have a physical book in their hands, to spread out on the desk next to 
them; to earmark, highlight, and mark with post-its; and take notes in, as evidenced by you hold-
ing this book at this moment. Hardcopy documentation has an important role to play in the dis-
semination of information, even in a highly dynamic electronic age. The following items are still 
provided in hardcopy format.

n The Quick Start pamphlet acts as a rough outline for issues from installation to getting 
help. It is approximately ten pages and contains information that complete new users 
need to know.

n The Quick Reference Guide is a fold-out card that has reminders of some of the symbols 
displayed in the FeatureManager and other locations, as well as some of the default hot-
keys and customization options.

Identifying SolidWorks Documents
SolidWorks has three main data type files. However, there are additional supporting types that 
you may want to know if you are concerned with customization and creating implementation 
standards. Table 1.1 outlines the document types.
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 TABLE 1.1

Document types
Design Documents Description

.SLDASM SolidWorks Assembly File Type

.SLDDRW SolidWorks Drawing File Type

.SLDPRT SolidWorks Part File Type

Templates and Formats Description

.asmdot. Assembly Template

.asmprp Assembly custom properties tab template

.drwdot Drawing Template

.drwprp Drawing custom properties tab template

journal.doc Design Journal Template

.prtdot Part Template

.prtprp Part custom properties tab template

.sldbombt BOM Template (table-based)

.sldtbt General Table Template

.slddrt Drawing Sheet Format

.sldholtbt Hole Table Template

.sldrevtbt Revision Table Template

.sldwldtbt Weldment Cutlist Template

.xls BOM Template (Excel-based)

Library Files Description

.sldblk Blocks

.sldlfp Library Part File

Styles Description

.sldgtolfvt Geometric Tolerance Style

.sldsffvt Surface Finish Style

.sldweldfvt Weld Style

Symbol Files Description

gtol.sym Symbol file allows you to create custom symbols

swlines.lin Line Style definition file allows you to create new line styles

Others Description

.btl Sheet Metal Bend Table

calloutformat.txt Hole Callout Format File
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Others Description

.sldclr Color Palette File

.sldreg SolidWorks Settings File

.sldmat Material Database

.sldstd Drafting standard

.swb, swp Macros, Macro Features

.txt Custom Property File, Sheet Metal Bend Line Note File

.xls Sheet Metal Gauge Table

Saving your setup
If you have taken time to set up a computer and then need to reinstall SolidWorks, move to 
another computer, or duplicate the setup for another user, you need to copy out the files you have 
used or customized. All these files are located by default in different folders within the SolidWorks 
installation directory. Chapter 2 deals with interface settings and creating a registry settings file to 
copy to other computers or use as a backup, but that does not address also copying the files of var-
ious types that also comprise an installation customization.

BEST PRACTICEBEST PRACTICE Especially when you are doing complex implementations that include templates for 
various types of tables or customized symbol files, it is important to have copies of 

these files in a location other than the default installation folder. Uninstalling SolidWorks or 
installing a new version will wipe out all of your hard work. Use the Tools ➪ Options ➪ File loca-
tions to locate these files in separate library folders that can be on the local hard drive or on a 
network location.

Templates
I have included some of my part and assembly templates on the CD-ROM for you. Copy these files 
to the location specified at Tools ➪ Options ➪ File Locations ➪ Document Templates.

When you begin to create a new document, and the New SolidWorks Document dialog box gives 
you the option to select one of several files to start from, those files are templates. Think of tem-
plates as “start parts” that contain all of the document-specific settings for a part (Tools ➪  
Options ➪  Document Properties). The same concept applies to assemblies and drawings. 
Templates generally do not have any geometry in them (although it is possible).

TIPTIP The Novice interface for the File, New SolidWorks Document dialog box only allows 
you to select default templates. The Advanced interface allows you to select any 

available template.

As shown in Figure 1.9, several tabs can be displayed on the advanced interface. Each of these tabs 
is created by creating a folder in the template directory specified in Tool ➪ Options.
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 FIGURE 1.9

The Novice and Advanced interfaces for the New SolidWorks Document dialog

Using multiple document templates
Using multiple templates enables you to start working from multiple starting points, which is an 
advantage in many situations such as:

n Standardization for a large number of users

n Working in various units

n Preset materials

n Preset custom properties

n Parts with special requirements, such as sheet metal or weldments

n Drawings of various sizes with formats (borders) already applied

n Drawings with special notes already on the sheet
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CROSS-REFCROSS-REF Drawing templates and formats are complex enough that I cover them in a separate 
chapter. Chapter 20 Automating Drawings – The Basics discusses the differences 

between templates and formats and how to use them to your best advantage. This chapter 
addresses part and assembly templates.

Depending on your needs, it might be reasonable to have templates for metric and inch part and 
assembly, templates for steel and aluminum, and templates for sheet metal parts and for weld-
ments, if you design these types of parts. If your firm has different customers with different 
requirements, you might consider using separate templates for those customers. Over time, you 
will discover the types of templates you need, because you will find yourself making the same 
changes over and over again.

To create a template, open a document of the appropriate type (part or assembly), and make the 
settings you wish the template to have; for example, units are one of the most common reasons to 
make a separate template, but in fact any of the Document Property settings is fair game for a tem-
plate, from the dimensioning standard used to image quality settings.

CROSS-REFCROSS-REF Document Property settings are covered extensively in Appendix B.

Some document specific settings are not contained in the Document Properties dialog box. Still, 
these settings are saved with the template. Settings that fall into this category are the View menu 
entity type visibility options and the Tools ➪  Sketch Settings options.

Custom Properties are another piece of the template puzzle. If you use or plan to use BOMs (bills 
of materials), PDM (product data management), or linked notes on drawings, you need to take 
advantage of the automation options available with custom properties. Setting up custom proper-
ties is covered in detail in Chapter 20.

Also, the names of the standard planes are template specific. For example, the standard planes may 
be named Front, Top, and Side; or XY, XZ, and ZY; or Plane1, Plane2, and Plane3; or North, Plan, 
and East; or Elevation, Plan, and Side for different uses.

Locating templates
The templates folder is established at Tools ➪  Options ➪  File Locations ➪  Document Templates. 
This location may be a local directory or a shared network location. Multiple folders may be speci-
fied in the list box, each of which corresponds to a tab in the New Document’s Advanced interface.

Once all of the Document Properties, custom properties, and other settings are set to your liking 
and you are ready to save the file as a template, click File ➪  Save As and in Files of Type, select 
Part Templates. SolidWorks prompts you to save the template in the first folder listed in the File 
Locations list. You can create assembly templates in the same way, but changing the settings for an 
assembly document.

You can also create additional tabs on the New SolidWorks Document dialog box can also be cre-
ated by making subfolders in the main folder specified in the File Locations area. For example, if 
your File Locations list for Document Templates looks like Figure 1.10, then your New dialog will 
look like Figure 1.11.
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 FIGURE 1.10

Tools ➪  Options ➪ File Locations list

 FIGURE 1.11

New SolidWorks Document dialog box

Adding subfolders to either of the locations listed in File Locations results in additional tabs in the 
New dialog, as shown in Figures 1.12 and 1.13.

 FIGURE 1.12

Additional subfolders added to a File Locations path

 FIGURE 1.13

Resulting tabs in New SolidWorks Document dialog box
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Default templates
Default templates are established at Tools ➪  Options ➪  Default Templates. The default templates 
must be in one of the paths specified in File Locations. Figure 1.14 shows the Default Templates 
settings.

 FIGURE 1.14

Tools ➪ Options ➪ Default Templates settings

The Default Template option, Always use these default document templates Prompt user to select 
document template, applies to situations when a template is required by an automatic feature in 
the software such as an imported part, or a mirrored part. In this situation, depending on the set-
ting selected, the system either automatically uses the default template or the user is prompted to 
select a template.

PERFORMANCEPERFORMANCE Allowing the software to apply the default template automatically can have a great 
impact on speed. This is especially true in the case of imported assemblies, which 

would require you to manually select templates for each imported part in the assembly if the 
Prompt user... option is used.

Sharing templates
If you are administering an installation of a large number of users, or even if there are just a couple 
of users working on similar designs, shared templates are a must. If every user is doing what she 
thinks best, you may get an interesting combination of conflicting ideas, and the consistency of the 
company’s documentation may suffer. Standardized templates cannot make users model, assemble, 
and detail in exactly the same way, but they do start users off on the same foot.

To share templates among several users, create a folder for templates on a commonly accessible 
network location, preferably with read-only access for users and read-write permissions for admin-
istrators. Then point each user’s File Locations and Default templates to that location. Access prob-
lems due to multiple users accessing the same files do not arise in this situation because templates 
are essentially copied to create a new document, not used directly.
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CAUTION CAUTION One of the downfalls of this arrangement is that if the network goes down, users no 
longer have access to their templates. This can be averted by also putting copies of 

the templates on the local computers; however, it has the tendency to undermine the goal of 
consistent documentation. Users may tend to use and customize the local templates rather than 
use the standardized network copies.

CAD administration and organizing any group of people on some level always comes down to 
trusting employees to do the right thing. There is no way to completely secure any system 
against all people trying to work around the system, so you must rely on having hired people you 
can train and trust.

Understanding Feature-Based Modeling
There is some terminology that you need to come to grips with before diving into building models 
with SolidWorks. Notice that I talk about “modeling” rather than “drawing,” or even “design.” This 
is because SolidWorks is really virtual prototyping software. Whether you are building an assembly 
line for automotive parts or designing decorative perfume bottles, SolidWorks can help you visual-
ize your geometrical production data in the most realistic way possible without actually having it 
in your hand. This is more akin to making a physical model in the shop than drawing on paper.

“Feature-based” modeling means that you build the model by incrementally identifying functional 
shapes, and applying processes to create the shapes. For example, you can create a simple box by 
using the Extrude process, and you can create a sphere by using the Revolve process. However, 
you can make a cylinder by using either process, by revolving a rectangle or extruding a circle. You 
start by visualizing the 3D shape, and then apply a 3D process to a 2D sketch to create that shape. 
This concept on its own is half of what you need to know to create models with SolidWorks.

Figure 1.15 shows images of simple feature types with the 2D sketches from which they were created.

Many different feature types in SolidWorks enable you to create everything from the simplest 
geometry shown previously to more complex artistic or organic shapes. In general, when I talk 
about modeling in this book, I am talking about solid modeling, although SolidWorks also has a 
complete complement of surfacing tools. I will discuss the distinction between solid and surface 
modeling in Chapter 27.

Table 1.2 lists some of the most common features that you find in SolidWorks, and classifies them 
according to whether they always require a sketch, a sketch is optional, or they never require a 
sketch.
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 FIGURE 1.15

Simple extruded and revolved features

 TABLE 1.2

Feature Types
Sketch Required Sketch Optional No Sketch (Applied Features)

Extrude Loft Fillet

Revolve Sweep Chamfer

Rib Dome Draft

Hole Wizard Shape Shell

Wrap Deform Flex

In addition to these features, there are other types of features that create reference geometry (such 
as curves, planes, and axes, surface features (covered in Chapter 27), and specialty features for 
techniques like weldments (Chapter 31), plastics/mold tools (Chapter 32), and sheet metal 
(Chapters 29 & 30).
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Understanding History-Based Modeling
In addition to being feature-based, SolidWorks is also history-based. To show the process history, 
there is a panel to the left side of the SolidWorks window called the FeatureManager. The 
FeatureManager keeps a list of the features in the order in which you have added them. It also 
enables you to reorder items in the tree (in effect, to change history). Because of this, the order in 
which you perform operations is important. For example, consider Figure 1.16. This model was 
created by the following process, left to right starting with the top row:

 1. Create a sketch.

 2. Extrude the sketch.

 3. Create a second sketch.

 4. Extrude the second sketch.

 5. Create a third sketch.

 6. Extrude Cut the third sketch.

 7. Apply fillets.

 8. Shell the model.

If the order of operations used in the previous part were slightly reordered (by putting the shell 
and fillet features before Step 6), the resulting part would also look slightly different, as shown in 
Figure 1.17.

Figure 1.18 shows a comparison of the FeatureManager design trees for the two different feature 
orders. You can reorder features by dragging them up or down the tree. Relationships between fea-
tures can prevent reordering; for example, the fillets are dependent on the second extruded feature, 
and cannot be reordered before it. This is referred to as a Parent/Child relationship.

CROSS-REFCROSS-REF Reordering and Parent/Child relationships are discussed in more detail in Chapter 
11, Editing and Evaluation.

ON the CD-ROMON the CD-ROM The part used for this example is available in the material from the CD-ROM, named 
Chapter 1 — Features.SLDPRT. Parts on the CD-ROM exist for both 2007 and 2009 

versions.

The order of operations, or history, is important to the final state of the part. For example, if you 
change the order so that the shell comes before the extruded cut, the geometry of the model 
changes, removing the sleeve inside instead of the hole on top. You can try this for yourself by 
opening the part indicated previously, dragging the Shell1 feature in the FeatureManager, and 
dropping it just above the Cut-Extrude1 feature.

NOTENOTE You can only drag one item at a time in the FeatureManager. So you may drag the 
Shell, and then drag each of two fillets, or you could just drag the Cut feature down 

the tree. Alternatively, you can put the shell and fillets in a folder and drag the folder to a new 
location.

Reordering is limited by parent-child relationships between dependent features.
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 FIGURE 1.16

Features used to create a simple part
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 FIGURE 1.17

Using a different order of features for the same part

 FIGURE 1.18

Compare the FeatureManager design trees for the parts shown in Figure 1.16 and Figure 1.17.

CROSS-REFCROSS-REF You can read more about reordering folders in Chapter 11, Editing and Evaluations.

In some cases, reordering the features in the FeatureManager may result in geometry that might 
not make any sense; for example, if the fillets are applied after the shell, they might break through 
to the inside of the part. In these cases, SolidWorks gives an error that helps you to fix the problem.

In 2D CAD programs where you are just drawing lines, the order in which you draw the lines does 
not matter. This is one of the fundamental differences between history-based modeling and non-
history-based drawing.
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Features are really just like steps in building a part; the steps can either add material or remove it. 
However, when you make a part on a mill or lathe, you are only removing material. The 
FeatureManager is like an instruction sheet to build the part. When you reorder and revise history, 
you change the order of operations and thus the final result.

Sketching with Parametrics
You have already seen that sketching is the foundation that underlies the most common feature 
types. You will now find that sketching in parametric software is vastly different from drawing 
lines in 2D CAD.

Dictionary.com defines the word parameter as “one of a set of measurable factors . . . that define a 
system and determine its behavior and [that] are varied in an experiment.” SolidWorks sketches 
are parametric. What this means to you as a SolidWorks user in a practical sense is that you can 
create sketches that change according to certain rules, and maintain relationships through those 
changes. This is the basis of parametric design. It extends beyond sketching to all of the types of 
geometry you can create in SolidWorks.

In addition to 2D sketching, SolidWorks also makes 3D sketching possible. Of the two methods, 
2D sketches are by far the more widely used. You create 2D sketches on a selected plane, planar 
solid, or surface face, and use them to establish shapes for features such as Extrude, Revolve, and 
others. Relations in 2D sketches are often created between sketch entities and other entities that 
may or may not be in the sketch plane. In situations where other entities are not in the sketch 
plane, the out-of-plane entity is projected into the sketch plane in a direction that is normal to the 
sketch plane. This does not happen for 3D sketches.

You use 3D sketches for the Hole Wizard, routing, and weldments, among other applications such 
as complex shape creation.

CROSS-REFCROSS-REF For more information on 3D sketching, please refer to Chapter 31.

For a simple example of working with sketch relations in a 2D sketch, consider the sketch that is 
shown in Figure 1.19. The only relationships between the four lines are that they form a closed 
loop that is touching end to end, and one of the corners is coincident to the part origin. The small 
square icon near the origin shows the symbol for a coincident sketch relation. The setting to enable 
or disable these sketch relation symbols is found at View ➪ Sketch Relations.

If you drag any of the unconstrained corners (except for the corner that is coincident to the origin), 
the two neighboring lines will follow the dragged endpoint, as shown in Figure 1.20. Notice the 
ghosted image left by the original position of the sketch. This is helpful when experimenting with 
changes to the sketch because you can see both the new and the old states of the sketch. The set-
ting to enable or disable this ghosted position is found at Tools ➪ Options ➪ Sketch ➪ Ghost Image 
On Drag.
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 FIGURE 1.19

A sketch of four lines

 FIGURE 1.20

Dragging an endpoint

If you add a parallel relation between opposing lines, they now act differently, as shown in Figure 
1.21. A parallel relation is added by selecting the two lines to be made parallel and selecting 
Parallel from the PropertyManager panel. You can also select the Parallel relation from the context 
bar that pops up in the graphics window when you have both lines selected.

CROSS-REFCROSS-REF You can read more about the PropertyManager in Chapter 2, Navigating the 
SolidWorks Interface..

 FIGURE 1.21

Dragging an endpoint where lines have relations

Next, a second parallel and a horizontal relation are added, as shown in Figure 1.22. If you are fol-
lowing along by re-creating the sketch on your computer, you will notice that one line has turned 
from blue to black.
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 FIGURE 1.22

Horizontal and parallel relations are added.

The colors represent sketch states. It may be impossible to see this in the black and white printing 
of this book, but if you are following along on your own computer, you can now see one black line 
and three blue lines. Sketch states include Underdefined, Overdefined, Fully Defined, Unsolvable, 
Zero Length, and Dangling.

n Blue: Underdefined. The sketch entity is not completely defined. You can drag a portion 
of it to change size, position, or orientation.

n Red: Overdefined. This can mean a number of things, but it is usually caused by con-
flicting relations or dimensions. For example, if a line has both horizontal and vertical 
relations, it becomes overdefined because one of the relations is satisfied, while the other 
is not.

n Black: Fully Defined. The sketch entity is fully defined by a combination of sketch rela-
tions and dimensions. A sketch cannot be fully defined without being connected in some 
way to something external to the sketch, such as the part origin or an edge. Multiple 
external entities may be used, as appropriate. (The exception to this rule is the use of the 
Fix constraint, which, although effective, is not a recommended practice.)

n Pink: Unsolvable. The difference between pink and red is that red conflicts with another 
relation but is in a potentially correct location, whereas pink conflicts with another rela-
tion, but is not able to move to a correct location, generally because of another red entity.

n Yellow: Zero Length. Solving the sketch relations would result in a zero-length entity; 
for example, this can occur where an arc is tangent to a line, and the centerpoint of the 
arc is also coincident to the line.

n Brown: Dangling. The relation has lost track of the entity to which it was connected.

There can be entities with different states within a single sketch. Also, endpoints of lines can have a 
different state than the rest of the sketched entity. For example, a line that is sketched horizontally 
from the origin has a coincident at one endpoint to the origin, and the line itself is horizontal. As a 
result, the line and first endpoint are black, but the other endpoint is underdefined because the 
length of the line is not defined. Sketch states are indicated in the lower-right corner of the graph-
ics window and also in the status bar. You can see that dragging one corner allows only the lines to 
move in certain ways, as shown in Figure 1.23.
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 FIGURE 1.23

Sketch motion is becoming more constrained.

In addition to sketch relations. dimensions applied using the Smart Dimension tool are also part of 
the parametric scheme. If you apply an angle dimension (by clicking the two angled lines with the 
Smart Dimension tool) about the origin and try dragging again, as shown in Figure 1.24, you see 
that the only aspect that is not locked down is the length of the sides. Notice also that when the 
angle dimension is added, another line turns black.

 FIGURE 1.24

Open degrees of freedom can be dragged.

Finally, adding length dimensions for the unequal sides completes the definition of the sketch, as 
shown in Figure 1.25. At this point, all lines have turned black. This is the state that we call “fully 
defined.” Between the dimensions and sketch relations, there is enough information to re-create 
this sketch exactly.

BEST PRACTICEBEST PRACTICE It is considered best practice to fully define all sketches. However, there are times 
when this is not practical. When you create freeform shapes, generally through the 

use of splines, these shapes cannot easily be fully defined, and even if they are fully defined, the 
extra dimensions are usually meaningless, because it is impractical to dimension splines on man-
ufacturing drawings.

It is the idea of reacting to change that is of most concern regarding parametric sketching. There 
are other factors that can also drive the sketch, such as equations, other model geometry that is 
external to the sketch, and even geometry from another part in an assembly, as you shall see later.
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 FIGURE 1.25

The fully defined sketch cannot be dragged, and there are no degrees of freedom.

Understanding Design Intent
“Design Intent” is a phrase that you will hear SolidWorks users use a lot. I like to think of it as 
“design for change.” Design Intent means that when you put the parametric sketch relations 
together with the feature intelligence, you can build models that react to change in predictable 
ways.

An example of Design Intent could be a statement in words that describes general aspects that help 
define the design of a part, such as “This part is symmetrical, with holes that line up with Part A, 
and thick enough to be flush with Part B.” From this description, and the surrounding parts, it is 
possible to re-create the part in such a way that if Part A or Part B changes, the part being 
described updates to match.

Some types of changes can cause features to fail or sketch relations to conflict. In most situations, 
SolidWorks has ample tools for troubleshooting and editing that allow you to either repair or 
change the model. In these situations, it is often the Design Intent itself that is changing.

BEST PRACTICEBEST PRACTICE When editing or repairing relations, it is considered best practice to edit rather than 
delete. Deleting often causes additional problems further down the tree. Many 

users find it tempting to simply delete anything that has an error on it.

Editing Design Intent
Design Intent is sometimes thought of as a static concept that controls changing geometry. 
However, this is not always the way things are. Design Intent itself often changes, thus requiring 
the way in which the model reacts to geometric changes to also change. Fortunately, SolidWorks 
has many tools to help you deal with situations like this.
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View, Sketch Relations
To see the sketch relations is one of the most obvious tools necessary for visualizing existing 
Design Intent. You can show or hide icons that represent the relations using the menu selection 
View, Sketch Relations. When shown, these relations appear as a small icon in a small colored box 
in the graphics area next to the sketch entity. Clicking on the icon highlights the sketch elements 
involved in that relation. Refer to Figures 1.19 through 1.25 for examples of these relations.

TIPTIP View, Sketch Relations is an excellent candidate for use with a hotkey, thus 
allowing you to easily toggle the display on and off.

CROSS-REFCROSS-REF For more information on creating and managing hotkeys, see Chapter 2, Navigating 
the SolidWorks Interface.

You can use the sketch relation icons that are visible on the screen to delete relations by selecting 
the icon and pressing Delete on the keyboard. You can also use them to quickly tell the status of 
sketch relations by referring to the colors defined earlier.

Display/Delete Relations

 

 You can find the Display/Delete Relations tool on the Sketch toolbar or by selecting a sketch entity 
in an open sketch. The sketch status colors that were defined earlier also apply here, with the rela-
tions appearing in the appropriate color. (Relations are not shown in blue or black, only the colors 
that show errors, such as red, yellow, pink, and brown.) This tool also allows you to group rela-
tions by several categories:

n All in This Sketch

n Dangling

n Overdefining/Not Solved

n External

n Defined in Context

n Locked

n Broken

n Selected Entities

In the lower Entities panel, you can also replace one entity with another, or repair dangling 
relations.

CROSS-REFCROSS-REF You can read more about repairing dangling entities in Chapter 11.

Suppressed sketch relations
Suppressing a sketch relation means that the relation is turned off and not used to compute the posi-
tion of sketch entities. Suppressed relations are generally used in conjunction with configurations.
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CROSS-REFCROSS-REF Configurations are dealt with in detail in Chapter 10.

Working with Associativity
Associativity in SolidWorks refers to links between documents, such as a part that has an associa-
tive link to a drawing. If the part changes, the drawing updates as well. Bi-directional associativity 
means that the part can actually be changed from the drawing. One of the implications of this is 
that you do not edit a SolidWorks drawing by simply moving lines on the drawing; you must 
change the model, which causes all views of the part or assembly to update correctly.

Other associative links include using base parts, where one part is inserted as the first feature in 
another part. This might be the case when you build a casting. If the part is designed in its “as cast” 
state, it is then inserted into another part where machining operations are performed by cut fea-
tures and the part is transformed into its “as machined” state. This technique is also used for plastic 
parts where a single shape spans multiple plastic pieces. A “master part” is created and split into 
multiple parts that could, for example, become a mouse cover and buttons.

One of the most important aspects of associativity is file management. Associated files are kept 
connected by filenames. If a document name is changed, and one of the associated files does not 
know about the change, then the association between the files can become broken. For this reason, 
you should use SolidWorks Explorer to change names of associated files. There are other tech-
niques that work, as well as some techniques that you should avoid.

BEST PRACTICEBEST PRACTICE It is considered poor practice to change filenames, locations or changing the name 
of a folder in the path of documents that are referenced by other documents with 

Windows Explorer. Links between parts, assemblies, and drawings can be broken in this way. 
Using SolidWorks Explorer or a Product Data Management, or PDM, application is the preferred 
method for changing filenames.

CROSS-REFCROSS-REF Refer to Appendix A, Implementing SolidWorks, for more detailed suggestions for 
file management techniques.

Tutorial: Creating a Part Template
This simple tutorial steps you through making a few standard part templates for use with inch and 
millimeter parts and some templates for a couple of materials, as well.

 1. Select from the menu Tools, Options ➪ System Options ➪ File Locations, and select 
Document Templates from the Show folder for list.

 2. Click the Add button to add a new path to a location outside of the SolidWorks 
installation directory; for example, D:\Library\Templates.

 3. Click OK to dismiss the dialog and accept the settings.
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 4. Select File ➪ New from the menu.

 5. Create a new Part document, selecting any template if using the Advanced interface.

 6. Select from the menu Tools ➪ Options ➪ Document Properties ➪ Detailing.

 7. Make sure the ANSI standard is selected.

 8. Change to the Units page.

 9. Change the unit system to IPS, inches, with 3 decimal places, using millimeters as 
the dual units, with 2 decimal places. Set angular units to Degrees with 1 decimal 
place.

 10. Change to the Grid/Snap page.

 11. Turn off Display grid.

 12. Change to the Image Quality page.

 13. Move the slider 2/3 of the way to the right, so it is closer to High. Make sure the Save 
tessellation with part document option is on.

 14. Click OK to save the settings and exit the Tools, Options dialog.

 15. RMB (right mouse button) on the Materials entry in the FeatureManager, and select 
1060 Alloy from the list.

 16. From the menu select File ➪ Properties, and click the Custom tab.

 17. Add a property called material of type Text. In the Value / Text Expression column, 
click the down arrow and select Material from the list. Notice that the Evaluated Value 
shows 1060 Alloy.

 18. Add another property called description and give it a default value of Description. 
At this point, the window should look like Figure 1.26.

 FIGURE 1.26

Setting up Custom Properties

 19. Click OK to close the Summary Information window.

 20. Change the names of the standard planes by clicking them twice slowly or clicking 
once and pressing F2. Rename them to Front, Top, and Side, respectively.
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 21. Ctrl-select the three planes from the FeatureManager, RMB and select Show.

 22. From the View menu, make sure that Planes is selected.

 23. RMB on the Front plane and select Insert Sketch.

 

 24. Select the Line tool and click and drag anywhere to draw a line.

  25. Select the Smart Dimension tool and click on the line, then click in space 
in the Graphics Window to place the dimension. If you are prompted for a dimen-
sion value, press 1 and click the checkmark, as shown in Figure 1.27.

 FIGURE 1.27

Drawing a line and applying a dimension

 26. Press Esc to exit the Dimension tool and RMB on the displayed dimension and 
select Link Value.

 27. Type thickness in the Name box, and click OK.

 28. Press Ctrl+B (rebuild) to exit the sketch, select the sketch from the 
FeatureManager, and press Delete on the keyboard.

NOTENOTE This exercise of creating the sketch and deleting it was done only to get the link 
value “thickness” entered into the template. Once this is done, every part made 

from this template that uses an Extrude feature will have an option box for Link to Thickness, 
which allows you to automatically establish a thickness variable for each part you create. This is 
typically a sheet metal part feature, but it can be used in all types of parts.

 29. Click File ➪ Save As and then select Part Template from the drop-down list. Ensure 
it is going into your template folder by giving it an appropriate name and clicking Save.

 30. Edit the material applied to change it from 1060 Alloy to Plain Carbon Steel, and 
save as another template with a different name.

 31. Change the primary units to millimeters with 2 places, and save as a third template file.

 32. Exit the file.
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Summary
Product development is about design, but it is even more about change. You actually design 
something once, but you may modify it endlessly (or it may seem that way sometimes). Similarly, 
SolidWorks is about design, but it really enables change. Think of SolidWorks as virtual 
prototyping software that allows you to change your prototype rather than having to make a new 
one. Virtual prototypes will never completely replace physical models, but they may reduce your 
dependence on them to some extent.

SolidWorks is also about reusing data. Associativity allows you to model a part once and use it for 
Finite Element Analysis (FEA), creating 2D drawings, building assemblies, creating photorealistic 
renderings, and so on. When you make changes to the model, your drawing is automatically 
updated, and you don’t have to reapply FEA materials and conditions or redo the rendering setup. 
Associativity saves you time by reusing your data. Associativity and change driven by feature-based 
and history-based modeling can take some getting used to if you have had limited exposure to it, 
but with some practice, it becomes intuitive and you will see the many benefits for enabling 
change. Parametric sketching and feature creation help you to maintain Design Intent and also 
adjust it as necessary.


